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LEGAL NOTICES

THIS DOCUMENT CONTAINS CONFIDENTIAL AND TRADE SECRET
INFORMATION OF FOCUS ENHANCEMENTS AND ITS RECEIPT OR
POSSESSION DOES NOT CONVEY ANY RIGHTS TO REPRODUCE
OR DISCLOSE ITS CONTENTS, OR TO MANUFACTURE, USE, OR
SELL ANYTHING THAT IT MAY DESCRIBE. USE IN WHOLE OR IN
PART WITHOUT THE SPECIFIC WRITTEN AUTHORIZATION OF
FOCUS ENHANCEMENTS IS STRICTLY FORBIDDEN.

EVERY EFFORT HAS BEEN MADE TO ENSURE THAT THE
INFORMATION IN THIS DOCUMENT IS COMPLETE AND ACCURATE
AT THE TIME OF PRINTING; HOWEVER, THE INFORMATION
CONTAINED IN THIS DOCUMENT IS SUBJECT TO CHANGE.

Copyright 2006 Focus Enhancements
All Rights Reserved

The material contained in this document is also protected by
copyright laws of the United States of America and other
countries. It may not be reproduced or distributed in any form by
any means, altered in any fashion, or stored in a data base or
retrieval system, without express written permission of FOCUS
ENHANCEMENTS.

FOCUS ENHANCEMENTS cannot be responsible for
unauthorized use of equipment and will not make allowance or
credit for unauthorized use or access.
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Contacting FOCUS ENHANCEMENTS:

USA
Office Hours:

Email:
Telephone:
Fax:
Address:

Monday through Friday
8:00 AM to 5:00PM (Central Time)

support@focusinfo.com
+1 763-398-1658
+1 763-571-7688

Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008
www.focusinfo.com

EMEA (Europe, Middle East, Africa)

Office Hours:

Email:
Telephone:
Fax:
Address:

Monday through Friday
9:00 AM to 5:00PM

techsupport@como.com
+49 4307 - 83 58 58
+49 4307 - 83 58 99

COMO Computer & Motion GmbHA
A Focus Enhancements Company
Lise-Meitner-Str. 15

24223 Raisdorf / Germany
www.focusinfo.com
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Regulations and Safety

Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008

Model Number: FS-4 HD and FS-4Pro HD

Date of Manufacture:
Reference the Serial Number label attached to
the unit.

Serial Number

The serial number for this equipment is located on the back of the
unit. Please write this serial number on the enclosed warranty
card and keep it in a secure area.

FCC Class A

This product satisfies FCC regulations when shielded cables and
connectors are used to connect the unit to other equipment. To
prevent electromagnetic interference with electric appliances
such as radios and televisions, use shielded cables and
connectors.

This equipment has been tested and found to comply within the
limits for a Class A digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio
communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off
and on, correct the interference by one or more of the following:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

* Connect the equipment to an outlet on a circuit different
from that used by the receiver.

* Consult the dealer or an experienced radio/TV technician
for help.
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Symbol Used In the FS-4 HD and FS-4Pro HD Unit
: This symbol indicates the presence of an uninsulated

Dangerous Voltage within the product’s enclosure
that may constitute a risk of electric shock to persons.

Symbols Used in This Documentation

& Important Information the User Should Read
This symbol indicates information about conditions or
actions that could result in damage to the device or
data.

@Note

Information of Interest to the User
This symbol indicates supplemenatry information about fea-
tures, functions, or operations that may be of interest to the user.

Documentation

Read, Retain, and Follow Instructions
All the safety and operating instructions should be read before
the product is operated.

¢ Retain Documentation
Place documentation in a secure place for future reference
on operating and safety instructions.

* Follow All Operating and Safety Instructions

* Pay Attention to All Warnings
Warnings are provided to protect the operator, the
equipment, and content.
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Electrical Precautions

Do Not Expose to Moisture
Do not use this product near water or in an environment where it
is exposed to dampness or there is the possibility of it getting
wet.

Do Not Remove Cover

There are No User Serviceable Parts inside this unit. Servicing
should be done by qualified service personnel.

ON / OFF Switch in Stand-By Position

The On/Off switch Does Not Separate the Unit From the Main Power
when it is in the stand-by position.

Power Sources

Use only power sources that match those indicated on the
marking label. If unsure sure of the type of power supply that is
available, consult your dealer or local power company.

Do Not Overload Power Outlets

Do not overload wall outlets, extension cords, or integral
convenience receptacles as this can result in a risk of fire or
electric shock.

Verify Power Plugs are Fully Inserted

To prevent potential electrical shock to personnel, verify that the
FS-4 HD/Pro HD power cord plug is fully inserted in to a
grounded receptor and that the plug blades are not exposed.

ATTENTION

POUR PREVENIR LES CHOCS ELECTRIQUES NE PAS UTILISER
CETTE FICHE POLARISEE AVEC UN PROLONGATEUR, UNE PRISE
DE COURANT OU UNE AUTRE SORTIE DE COURANT, SAUF SI LES
LAMES PEUVENT ETRE INSEREES A FOND SANS EN LAISSER
AUCUNE PARTIE A DECOUVERT.

Power-Cord Protection

* Routing Power-Cords
Route power supply cords so that they are not likely to be
walked on or pinched by items placed upon or against them.
Avoid sharp angles in the cord, particularly at plugs,
convenience receptacles, and the point where they exit the
product.
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* Non-Use Period
During extended periods when the device is not used,
unplug it from the power source and retract the power-cord.

Grounding or Polarization

* Polarized
If this product is equipped with a polarized alternating
current line plug (a plug having one blade wider than the
other), it will fit into the outlet only one way. This is a safety
feature. If you are unable to insert the plug fully into the
outlet, try reversing the plug. If the plug should still fail to
fit, contact your electrician to replace your obsolete outlet.
Do not defeat the safety purpose of the polarized plug.

¢ Grounded
If this product is equipped with a three-wire grounding type
plug, a plug having a third (grounding) pin, it will only fit
into a grounding type power outlet. This is a safety feature.
If you are unable to insert the plug into the outlet, contact
your electrician to replace your obsolete outlet. Do not
defeat the safety purpose of the grounding type plug.

Outdoor Antenna Grounding

Grounding

Clamp -/

If an outside antenna or
cable system is connected
_ Antenna Leadkin Wire to the FS-4 HD/Pro HD,
' verify that the antenna or
cable system is

anennapiscarge uoie -~ grounded. This provides
some protection against
Grounding Clamps voltage surges and built-
up static charges.

Refer to Article 810 of the
National Electric Code, ANSI/NFPA 70, for information about
the proper grounding of the mast and supporting structure,
grounding of the lead-in wire to an antenna discharge unit, size
of grounding connectors, location of antenna discharge unit,
connection to grounding electrodes, and requirements for the
grounding electrode.

Antenna

Electric Service
Equipment

Power Service Grounding—
Electrode System

Figure A National Electric Code

Lightning and Power Surges

During electrical storms or when left unattended and unused for
long periods of time, unplug the FS-4 HD or FS-4Pro HD from
the power source and disconnect the antenna or cable system.
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Power Lines

Do not locate an outside antenna system in the vicinity of
overhead power lines, electric light or power circuits, or where it
can fall onto such lines or circuits.

When installing an outside antenna system, extreme care should
be taken to keep from touching such power lines or circuits as
contact with them might be fatal.

Optical Precaution

The use of optical instruments with this device will increase
hazards to the eyes hazard.

Maintenance and Moving

Cleaning

Unplug this product from the wall outlet before cleaning. The
product should be cleaned only with a polishing cloth or a soft
dry cloth. Never clean with furniture wax, benzine, insecticides
or other volatile liquids since they may corrode the cabinet.

Servicing

Unplug the device from the power outlet and refer servicing to
qualified service personnel under the following conditions:

When the power-supply cord or plug is damaged.

If liquid has been spilled, or objects have fallen into the
product.

If the product has been exposed to rain or water.

If the product does not operate normally when following the
operating instructions. Adjust only those controls that are
covered by the operating instructions. The incorrect
adjustment of other controls can result in damage and often
requires extensive work by a qualified technician to restore
the product to its normal operation.

If the product has been dropped or damaged in any way.

When the product exhibits a distinct change in performance.
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Accessories and Replacement Parts

Use only attachments and accessories recommended by Focus
Enhancements.

Use only replacement parts specified by the Focus Enhancements
or of comparable quality and characteristics as the original parts.

Unauthorized substitution of parts can result in fire, electrical
shock, other hazards, and loss of warranty.

Safety Check

Upon completion of any service or repairs to this product, ask the
service technician to perform safety checks to determine that the
product is in proper operating condition.

Operating Environment
Location

Any mounting of this device should follow its instructions, and
should use only mounting accessories recommended by Focus
Enhancements.

* Install this device on a sturdy, level surface, away from
moisture and dust.

* Heat
Locate this device away from heat sources such as radiators,
heat registers, stoves or other electrical devices (including
amplifiers) that generate heat.

Ventilation

Do not block the ventilation openings in the FS-4 HD/Pro HD
body. Overheating can occur and damage the device. Do not
place this device in a built-in installation, such as a bookcase or
rack, unless proper ventilation is provided.
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Introduction

Thank you for purchasing this Focus Enhancements portable direct-
to-edit (DTE) disk recorder. The FS-4 HD and the professional version
FS-4Pro HD are the first portable DV/HD disk recorders with DTE
technology designed for hand held camcorders in a small, rugged
and shock proof chassis.

@iote

Information About Specific FS-4 HD Models
Throughout this manual, FS-4 HD indicates information that pertains to all
models of the FS-4 HD family.

The acronyms DV and HD refer to the recorder’s video recording format,
digital or high definition, respectively. By default, both the FS-4 HD and
FS-4Pro HD employ DV and HD recording.

If you edit with applications from Adobe, Apple, Avid,
Canopus, Matrox, Pinnacle, Sony, Ulead, and many others,
Focus Enhancements’ DTE Technology is the only solution that
can save you hundreds of hours a year by recording clips to
disk in your non-linear editor’s (NLE) native file format.

DTE Eliminates Pre-edit Processing

The FS-4 HD DTE disk recorder eliminates the need to capture,
transfer or convert video clips before editing. The FS-4 HD is a
stand-alone device that records DV25, HD 720p, and HD 1080i
video to its disk drive as a NLE native file. The HD versions
add the capability of capturing to disk HD 720p and 1080i
video from HDV camcorders equipped with a 1394 interface.
For most DV and many HDV compatible NLE systems, when
the disk drive is connected to a computer the clips are
immediately available for editing.

Shoot, connect, and edit: it is now that easy.
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Unpacking

FS-4 HD ang FS-d4Pro
HD
Portable DTE Recorders

User Guide

‘ MANL-0954.04

Verify that the FS-4 HD has the following items:

1.

2.
3.
4

No o

FS-4 HD unit

Belt Clip

User Guide

Two Firewire cables, a one foot and a four foot long, 6-
pin to 4-pin

Power cable (international only)

Power supply with cable and connector to the FS-4 HD
Removable Li-Ion battery pack

@iote

Missing or Damaged Components

If there are missing or damaged items, contact Focus Enhancements
Support for assistance.

USA Email: support@focusinfo.com

USA Telephone: +1 763-398-1658

EMEA Email: techsupport@como.com

EMEA Telephone: +49 4307 - 83 58 58

FS-4 HD and FS-4Pro HD Portable DTE Recorders



Introduction

Features

FS-4 HD Features
All FS-4 HD models offer the following features:

e Tapeless acquisition

Especially equipped camcorders permit the use of
Direct To Edit (DTE) Technology to record directly
from a camcorder while shooting and without the need
of a tape.

 True DTE Technology
When shooting is finished, connect the FS-4 HD to a
computer and instantly be ready to edit in the timeline.

Files are recorded to disk as RawDV, AVI Typel, AVI
Type2, Matrox AVI, Canopus AVI, or QuickTime. In
addition, 24p AVI Type2 and QuickTime are available
in NTSC mode.

Support for cutting edge HDV camcorders with 720p
and 1080i MPEG-2 capabilities equipped with a
FireWire 1394 connection

« Fast and Efficient Editing

When shooting is finished, mount the FS-4 HD to a Mac
or PC editing system like a typical FireWire hard disk
drive. Transfer clips to your NLE's media drive at up to
400 Mbps or edit instantly in real-time using the FS-4
HD as your media source.

* Confidence in Recording

Simultaneously record to disk and tape while you
shoot, providing an immediately available, drop out
free, edit source and an archive and backup on tape.
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Compact, Lightweight, Rugged Design

The FS-4 HD weighs about a pound including the
battery and is only 1.5" thick. You can mount the FS-4
HD directly to your camcorder using the optional
camera mount kit, or clip the FS-4 HD directly to your
belt. The FS-4 HD is designed to withstand the rigors of
field shooting. The six second electronic shock cache
ensures your video is always recorded even in the
roughest of conditions.

Flexible Capacities and Power

The FS-4 HD comes with a 40GB (about 3 hours) hard
drive. Extend record times by linking two FS-4 HD
units together. Power the FS-4 HD using slim,
removable battery packs or power it using the supplied
AC adapter.

Easy to Use, Control and Update

The FS-4 HD interfaces with your camcorder using a
single FireWire cable that passes audio, video, timecode
and control information. When a tape is present, each
press of start and stop on your camcorder's record
button creates an individual clip on disk. The FS-4 HD
features a comprehensive backlit display, menu system
and buttons allowing easy control and management. In
addition, these units are upgradeable in the field.

Never Miss A Shot

The FS-4 HD's six second retro record mode means you
are always recording. When action happens, you know
up to six seconds prior to the event occurring is saved
in your clip.

FS-4Pro HD Features
The FS-4Pro HD offers these additional professional features:

Retro Disk and Loop Record modes

Scene Marking

This allows categorizing video clips into pre-named
folders on the disk during a shoot.

User definable 10-second retro cache record feature

User definable time lapse and loop playback modes
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¢ Pinnacle, Avid DV-OMF, and MXF OPatom DV
support

¢ Available with a 60GB, 80GB or 100GB hard drive and
with equivalent record times of about 4.5, 6, or 7.5
hours respectively.

* Free Run and Regen timecode modes
*  QUICKTIME HD DTE format
* HD TC display and re-stripe capabilities
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Quickstart

This section provides the following information necessary for using
the FS-4 HD as quickly as possible.

Physical Description and Basic Controls ...............cocceuvvneeee. 8
The FS-4 HD Menu SYSEM .....vvviiiiiiiiieieeeeeeeseecininnveeeeees 15
Connecting the FS-4 HD to AC POWEr .........ueeviieiieiiaaaaaannn. 19
Installing / Removing the Battery Pack .............ccccccvvvveenen. 20
Connecting a FS-4 HD to a DV/HD Camcorder .................. 22
Record and Playback with the FS-4 HD ...............cooeeeiiins 23
Power Onthe FS-4 HD ... 23
Select HDD Recorder MOde .........cccveveeriiiiiiieniiiiiiee e 24
Select a DV/HD File FOrmat .........ccccoooiiiiiiiiiiiiiiiiceeeeeeeee 25
Set Time and Date ........c.ccoovviiiiiiiiiiiiee e 26
Record With the FS-4 HD .....ooooiiiiiiiiieee e 28
Manual RECOIAING .....vvvriiiiiiiieeeie i e e e 29
Syncro Slave Recording ..........eeeeeeeiiiieainiiiiiiiiiiieeieeeeeeen 30
Playback onthe FS-4 HD ..........cccoooeiiviiiiiiiccee e 31
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Physical Description and Basic Controls

Front Panel Controls

Function
buttons >
A B C
< SN Navigation
Power ON ——== ; ) <L buttons
Record \
Button Transport
& Control
buttons
Power OFF Speaker
and
Stop button
LCD Display
This is a backlit, 14 character by 7 line dot matrix display.
@Note

In event of a mild electrical discharge to the unit the LCD could go blank. To
correct, hold the SELECT button down for 5 seconds.

Function buttons (A, B, C)

Below the FS-4 HD LCD display are three user-defined
function buttons: A (left), B (center), and C (right). Use
them as short-cut keys for the most frequently selected
functions at the bottom of the LCD screen. The function of
these soft buttons changes, depending on the options
displayed above that specific button. Refer to the Functions
Screen on page 72 for more information.
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Power On Button
The Power ON button provides two functions.
» Power ON FS-4 HD

e Reset FS-4 HD

* FS-4 HD first must be powered on.

e Hold down the Power On button for more than a second.
* Power OFF

Hold down the OFF button ® for three (3) seconds.
During power off, the FS-4 HD beeps, indicating that it
is turning off.

Navigation Buttons

Use these buttons to navigate through the FS-4 HD menus.
The navigation buttons are Left, Right, Up, Down, and Select.

Transport Control Buttons

Play

Record

Back = : : Forward
— ) < =
Search _ SIearch

Back Forward
Index STOP Index
Power Off

Use these buttons to control FS-4 HD playback and record
functions. You usually operate these transport buttons
while on the HOME Screen.
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10

Record e

Press this button once when the FS-4 HD is in Stop mode to put
the FS-4 HD into REC-PAUSE. Press it again to start recording.
Pressing the Record button while recording, causes the current
clip to close and a new clip is created without dropping any
frames. This button is the only button that has a red legend on the
front panel.

Back Search €4«

Press this button to play video at speeds different than real-time.
Refer to the note in the Forward Search paragraph.

Play »

Press this button to start playback of the selected clip.

@iote

Some HD Camcorders Require a Moment to Synchronize

Some HD camcorders require a moment to synchronize the video from an
external source. Typically during this period, they display a solid blue or
black video until synchronized.

Forward Search »p
Press this button to play video at speeds different than real-time.

@iote

Fast Forward and Reverse
Pressing the Forward Search button multiple times results in increases in
the search speed, i.e. fast forward. This mode works both in forward and
reverse functions. For instance, if you are in 10X FF speed and you press
the Back Search button once, the FS-4 HD is now in 2X FF mode. This
applies as well to backward search speeds. The default speed resolution is
as follows (NTSC and PAL have slightly different multiples for < 1X)

¢ Reverse: -30X, -10X, -2X, -1X (reverse play), -1/2X(-15fps), Still.

» Forward: Still, +1/2X (+15fps), +1X (play), +2X, +10X, +30X

Fast Forward and Reverse Compatibility
During Fast Forward and Reverse modes, some camcorders do not display
video when played-back from an external device, such as the FS-4 HD.

Back Index |4«

This button returns the FS-4 HD to the beginning of the current
clip when in playback mode. Press this button twice in sequence
to return the FS-4 HD to the previous clip during playback. In
STOP mode, press this button to return the FS-4 HD to the
beginning of the previous clip.
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Pause, Stop ®m and Power OFF

While in the Home screen, and in any transport mode, press this
button to Pause the FS-4 HD. Press it again to stop the FS-4 HD.
Refer to the section, Setup Screens on page 62 for more
information.

To power off the FS-4 HD, hold down the Stop button ® for
three seconds. During power off, the FS-4 HD makes an audible
beep indicating it is turning off.

Forward Index »p|

Use this button to skip forward to the next clip in STOP and PLAY
modes.

Top Panel

The top panel contains the following connectors and LEDs:

Remote Contro|
(Serial Connector)

Camera
(FireWire Connector)

Computer
(FireWire Connector)

Status LED —
Charge LED —— gl

Charge LED States

LED Indicates

Off No Charger Connected

Green Charging Cycle Completed

Amber / Green Floating Charge Mode (Charging almost completed.)
Amber Fast Charge Mode (Maximum charging rate.)

Red Charging Error

Red / Amber No Battery Installed / Battery Error

Amber, flashing Insufficient Voltage to Charger
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Status LED States

LED Indicates
Off Power OFF
Green Power ON (Power On but there is no activity.)

Orange, solid Playback

Orange, fluttering Hard drive being accessed during playback.
Red, solid Recording Mode

Red, blinking Recording Pause

Computer FireWire Connector

* In/Out: 6-pin IEEE-139%4a port x 1
* Asynchronous Data I/O

Remote Control, Serial Connector
e GPI/ RS232C; 3.5mm TRS mini jack. (3.5mm to DB-9
cable accessory available).

* Can configure to act as a simple contact closure or RS-
232C port.

* Connect an optional wired remote commander.

Camera FireWire Connector
e DV/HD Video I/O
*  6-pin IEEE-1394a connector
¢ Isochronous 25Mb/s DV video I/O

FS-4 HD supports 1080i/720p video I/ O when used with
HDV camcorders equipped with a 1394 connection.

* DV Audio: embedded 2-channel (48kHz, 16-bit) or 2-
channel (12-bit, 32kHz) audio, 720p/1080i HDV MPEG1
Audio Layer IL

@iote

4-Channel Audio
4-channel (12-bit, 32kHz) audio is available only with RawDV
format.
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Rear Panel

The rear panel contains the following important items:

Fan Intake ; Belt Clip Post

Vent |- —— Battery
Do Not Block Compartment
Latch
< —— Battery
Compartment
Side Panel

The side panel contains cooling vents as illustrated below.

Cooling Vents /

Do Not Block

FS-4 HD and FS-4Pro HD Portable DTE Recorders 13
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Bottom Panel

The FS-4 HD bottom panel features a single 2-pin DC power
connector. Connect the supplied AC power adapter here.

DC Internal
Power Connector Speaker

Cooling Vent

Do Mot Blo Do Not Block

Internal Speaker
An internal speaker provides alarms and audible feedback.

To disable the audible feedback, go to the Settings menu
and select the ALARM OFF setting. However, the power,
temperature, and disk capacity alarms are always active.
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The FS-4 HD Menu System

The FS-4 HD menu system provides access to all the functions
available in the unit. Each of the screens below (except the
Welcome and Home screens which come up automatically
when the unit starts) are accessed by pressing the Left or Right
navigation buttons. The functions of each of the selections on
these screens is explained in more detail in FS Functions on page
47.

@iote

Returning to the Top of Menu or Home screen

To get to the top of any menu, press the Left button. To get back to the
Home screen:

» Highlight the screen title at the top of the screen.
* Press the Select button.

*+  Welcome
Only appears for several seconds upon power up.
* Home

Gateway screen for all functions, it displays disk and
operational status.

e Control

Contains the following selections:
* Local

* Syncro Slave

« AV/C

* Tapeless

* Play From FS-4Pro HD only

Provides lists to select play material from:
* Track List

* Reel List
 Play
Contains the following Play selections:
* Play Clip
*  Loop Clip
* Loop All
*  Play All
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e Reels FS-4Pro HD only

Allows selected clips to be marked for placement in
particular Reels Folders.

e ROO
e RI1
e R22
e R33
e R44
e R55
e R66
e R77
e R88
e R99
¢ NONE
o Utilities

Contains the following disk and clip functions:
¢ Delete Clip

* Format

*  Repair Disk

*  Repair Clip DV mode only

* File Name

* Upgrade

* System Reset

* Diagnostic

* Status

FS-4Pro HD provides the following additional functions:
* Organize Reel

*  Organize OMF

*  Organize MXF

*  Organize PINN

 Functions

Contains user definable function button selections.
Changing a setting with a Function button is identical
to changing the setting in its corresponding menu.
Refer to Functions Screen on page 72 for more
information.
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 Setup
Contains the controls for setting and reviewing the
FS-4 HD configuration:
*  Set Date (MM/DD/YY)
*  Set Time (HH:MM:SS)
¢ View Firmware Version
+ LCDLight ON
+ LCDLight OFF
« LCDLight AUTO
e Alarm ON
e Alarm OFF
* Stop Frame DV mode only
* Stop Gray DV mode only
* Stop No Video
e EXT CTL OFF
e EXT CTL PAUSE
e EXT CTL FRAME DV mode only
e EXT CTL FILE
* TCEXT (external)
e TCREC RUN DV mode or FS-4Pro HD only
e TCDROP NTSConly
e TC NON-DROP NTSC only
e LCD Contrast
FS-4Pro HD provides:
e TC FREE RUN DV mode or FS-4Pro HD only
* TCREGEN (regenerate) DV mode or FS-4Pro HD only

e TCSET

e UBSET

e HDVTCTYPE
« HDD Mode

Contains the following hard drive selections:
* DV Recorder

* HD Recorder

¢ DD Drive

* Use Ext. FS-4
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e DV or HD Formats

Following HDD mode is a menu of formats available
for the type recorder selected in HDD.

If DV Recorder was selected the following formats are

shown:

¢ Raw DV

e AVITypel
* AVIType2

¢ Canopus AVI

e Matrox AVI

*  Quicktime

¢ Quicktime 24P NTSC only
e 24P AVIType2

FS-4Pro HD provides:

¢ Pinnacle

¢ Avid OMF

¢  MXF OPAtom

When the HD Recorder option is selected, the formats
displayed are:

e M2T

FS-4Pro HD provides:

e QUICKTIME

e Record

Contains the following recording functions:
* Normal

* Retro Cache

FS-4Pro HD also contains:

e Retro Disk

*  Loop Record

* SNAP

¢ Time Lapse
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Powering the FS-4 HD

* The FS-4 HD operation without a battery installed.

To operate the FS-4 HD without a battery installed,
connect the unit to an AC power source.

» Before operating the FS-4 HD with battery power.

It is first necessary to fully charge the battery. An
uncharged battery, typically takes 2-3 hours to charge.

Connecting the FS-4 HD to AC Power

Attach the AC power cord to the FS-4 HD (with or without
battery installed). The FS-4 HD is immediately ready for
operation.

To do this, connect the AC power as follows:

DC Cable

Battery Pack

1. Plug the cord from the power supply into the bottom of the FS-4
HD.

2. Connect the line cord to the rectangular power supply
(International models only).

3. Plug the line cord or AC adapter into an electric outlet.
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Installing / Removing the Battery Pack

Installing a Battery

Batt

L:tcir)lgook Gently press down
Latch Slot Slide battery pack forward

Latch \A\‘

1. Place the unit, so that the battery compartment is up.

Position the batterﬁl pack, as shown above, so that the latch
hook is almost in the latch slot, and touching the floor of the
battery compartment.

3. Slide the battery forward while gently pressing down.
Feel the battery slide along guides and seat itself.
4. When seated, the battery latch clicks into place.

Removing a Battery

1.  Slide the battery latch to the left and hold.

2. Apply backward pressure to the battery pack at the
triangle/arrow and gently slide the pack back about 1cm.
or 3/8 inch.

This is the reverse motion of inserting the battery.
3. Remove the battery pack.
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Charging the Battery

The battery begins charging anytime it is connected to AC
power using the AC adapter supplied with the FS-4 HD.
The charge LED lights when the FS-4 HD is charging. For
information on the charge LED, refer to the subsection Top
Panel on page 11.

Before the battery can be used it must charge until the
battery status LED indicates the unit is fully charged

(green).

*  The Charge LED on the top of the FS-4 HD lights to show
the battery is charging.

* Anuncharged battery takes 2-3 hours to charge with the
unit powered off.

*  The battery provided with the FS-4 HD can supply
power to the unit for about 90 minutes while in
continuous Record or Playback mode.

* An optional high capacity battery capable of providing
power for almost three hours of continuous recording is
available from Focus Enhancements.

@Note

Using FireWire to Charge FS-4 HD

It is possible to charge the FS-4 HD battery through the 1394 port on a
computer provided that the computer outputs at least 15V through the port.
To determine if this is possible, consult the computer’s specifications.

Battery Use

A Misuse can cause property damage and/or bodily injury such as burns
if a conductive material such as jewelry, buttons, or beaded chains
touch exposed terminals. The conductive material may complete an
electrical circuit (short circuit) and become quite hot. Exercise care in
handling a charged battery, particularly when placing it inside a pocket,
purse, or other container with metal objects.

Warning: Do Not Use Unapproved Battery Chargers
A Use of battery chargers not approved by Focus Enhancements could
cause the battery to catch fire or explode.

Use Only Original Focus Enhancements FS-BC Battery Chargers
There are four versions of the optional FS-BC battery charger for use in
various parts of the world.

ASYF-0940-01 USA

ASYF-0941-01 Europe

ASYF-0943-01  United Kingdom

ASYF-0944-01  Australia
These optional battery chargers are available from either your local
dealer or online at the Focus Enhancements web store,
www.focusinfo.com/sales/store.
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Connecting a FS-4 HD to a DV/HD Camcorder

Before performing this procedure, make sure you have
installed and charged the battery, see Installing / Removing the
Battery Pack on page 20.

1. Connect the supplied Firewire cable to the DV I/O connector on

the top of the FS-4 HD. (Only one end will match the plug in the
FS-4 HD.)

2. Locate the FireWire/DV/iLink (or similar) connector on your
video camera. It is located in different places depending upon the
brand of camera. If you are unclear ofpits location, consult your
video camera manual.

@iote

FS-4 HD Supplied with 6-pin to 4-pin FireWire Cable
Some camcorders require a 6-pin to 6-pin FireWire, 1394, cable
and the cable provided with the FS-4 HD will need to be replaced.

3. Connect the other end of the FireWire, 1394, cable to your video
camera.

»

Turn on the video camera.
5. Turn on the FS-4 HD.
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Record and Playback with the FS-4 HD

Before using the FS-4 HD, set up the unit as outlined in the
following sections:

Power Onthe FS-4 HD ... 23
Select HDD Recorder MOde ........ccccceeeeiviiiiiiiiiiiiiiiieeaeeeen, 24
Select a DV/HD File Format ........cccooeeeiiiieieeiiiiiiiieeiiiians 25
Set TIMe anNd DAte ....covvvviviriiiiieieeeieeee e 26
Record Withthe FS-4 HD ........ooovviiiiiicicieie e 28
Manual ReCOIdiNG .....cooviiiiiiiieiiiiiiiee e 29
Syncro Slave Recording ..........eeeeeeeiiiieainiiiiiiiiiiieeeeeeee e 30
Playback onthe FS-4 HD .....ccooiiiiiiiiiiiiiieeciece e 31

The values set in these procedures are fixed and persist
through power cycles. To change them, repeat the steps
outlined above.

Power On the FS-4 HD

1. Press the Power ON button for more than one second and release
it.
Power ON

Navigation
Buttons

Transport

To power OFF,
hold down for 3-5 seconds.
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2. The Welcome screen appears and displays while the
FS-4 HD initializes. Each FS-4 HD model has a unique welcome
screen.

FS-4 HD FS Model
PORTABLE

DTE RECORDER

3. When the Home screen appears, proceed, see Home Screen on
page 49 for more details.

|| STOP 1-
COUNTER im

00:00:14:02
DISK 1 168 min

FS-4Pro HD—p»2 REEL
Only SYNC DISP LOCK

Select HDD Recorder Mode

1. Press the Right navigation button two times until the HDD Mode
display appears.

HDD MODE

-DV RECORDER
HD RECORDER

DD DRIVE
USE EXT FS-4

2. Use the Down navigation button to highlight the recorder mode,
either DV or HD.

3. Press the Select button on the navigation buttons.
4. Press the Left button to return to the menu title.

5. Press the Right button once and advance to the FORMAT screen.
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Select a DV/HD File Format

The formats displayed depend on the recorder mode selected
in the previous step, for example DV RECORDER results in the
following:

DV FORMATS
RAW DV

-AVI TYPE1
AVI TYPE2
CANOPUS AVI

1. Use the Up and Down navigation buttons to select the DV file
format that supports the preferred NLE system. A dash mark to
the left of a list item indicates that it is the current selection. The
default value is AVI Type2.

@Niote

DV24p and PAL 25p Modes
24p modes are only for use with camcorder's that are capable of
DV-24p Advanced mode.

PAL 25p camcorders require no special 25p DV format

Check www.focusinfo.com for Supported Applications

For a complete and up-to-date list of supported applications and
their associated formats, visit the website:
http://www.focusinfo.com

2. Press the center Select button on the navigation buttons.
3. Press the Left button to return to the menu title.

4. Press the Right button once and advance to the SETUP screen.
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Set Time and Date

@iote

Date and Time Must Be Set
The date and time must be set because they are used in the FS-4 HD file
naming function.

1. Press the Right navigation button several times until the Setup
display appears on the screen as shown below:

SETUP

09/15/05
11:21: 13

vV 1.0.0
-LCDLIGHT OFF

2. Use the Down navigation button to highlight the date and press
the Right navigation button to access the Set Date screen.

SET DATE

IX)/ 15/ 05
MM/ DD / YY

BACK

3. Use the Up and Down navigation buttons to change the
highlighted value. Use the Right and Left navigation buttons to
highlight the Month, Day, and Year.

4. When complete, press the right-most Function button indicated
as BACK on the screen. The new date will be indicated on the
Setup Screen.
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5. Use the Down navigation button to select the time and press the
Right navigation button. The following screen appears:

SET TIME

lﬂLﬂ;lB

HH: MM : SS

BACK

6. Use the Up and Down navigation buttons to change the
h1 hlighted value. Use the Right and Left navigation buttons to
i hght the Hour, Minute, and Second. (Time is indicated in
r. mode.)

7. Press the right-most Function button indicated as BACK on the
screen. The new date appears on the Setup Screen.

The Time and Date are now set.

8. Press the Left navigation button followed by the Select button to
return to the beginning screen.

For more information on the Setup function, refer to the section,
Setup Screens on page 62.
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Record With the FS-4 HD
There are two modes of recording with the FS-4 HD.

* Manual Recording
Control with the FS-4 HD transport buttons.

» Syncro Slave Recording or Tapeless Recording
Control recording with the video camera controls.

Before beginning recording, verify that:

1. Time and date are set.
2. Recording format is set.

3. The FS-4 HD is connected to the video camera
according to the explanation in Connecting a FS-4 HD to a
DV/HD Camcorder on page 22.

Camera and FS-4 HD are powered on.
Tape is loaded in the camera.

@Niote

Tapeless Operation
Tape does not need to be loaded if the camera supports tapeless
operation, refer to, Control Screen on page 94.

A

Troubleshooting: Counter Not Incrementing

If the Counter does not increment while recording the camera, it is an
indication that there is no active connection between the FS-4 HD and
the camera.

« Verify that the FS-4 HD 1394 DV /O and the camera connections
are secure. It may be necessary to unplug and then reconnect
them.

When a good connection is made, the Counter will increment and
recording will start.

Verify Record Mode Matches Source Video Content and Format
If in DV Recorder mode, HD content will not record properly. A NTSC
or PAL DV source records only on a matching NTSC or PAL unit.

A Do Not Disconnect Power or FireWire Cable
Never disconnect the power or the FireWire cable during a
recording. This will cause file corruption.

Loss of Power During Recording

If power is lost during recording it is possible to repair the
damaged file or files, refer Repair Disk on page 82 to and
Repair Clip DV mode only on page 83.
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Manual Recording

1. Set the video camera to Camera or Cam mode.
2. Verify that an image appears in the viewfinder.

3. On the FS-4 HD, press Record ® once.
This sets the FS-4 HD to Record-Pause mode.

Record ® —====l=

Stop m (OFF)

4. Onthe FS-4 HD, press Record ® button a second time. The
FS-4 HD begins to record. The timecode value is displayed
on the screen.

5. Press Stop m (OFF) once to return the FS-4 HD to
Record-Pause mode.

6. Press Record ® and the FS-4 HD begins to record again on
the same clip.

7. Press Stop m (OFF) twice to stop the recording.
8. Press Record ® twice to begin recording a new clip.
Creating a New File without Dropping Frames

When in record mode, it is possible to break the recording into a
separate, new file without dropping frames.

Press Record ® and the FS-4 HD automatically creates a new
clip.
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Syncro Slave Recording

Syncro slave recording allows the FS-4 HD to mimic
camcorder operations by monitoring the state of the
camcorder’s tape recorder controls.

1.
2.

Verify that the FS-4 HD is in STOP mode.

From the FS-4 HD Home screen, press the Right navigation
button several times until the Control screen appears:

CONTROL

LOCAL
AV/C

-SYNCRO SLAVE
TAPELESS

Use the Down navicigation button to select Syncro Slave. The
dash on the left side of an item indicates it is the current
selection. The default value is Local.

Press the Select navigation button.

The beginning screen returns and a Pause indicator
appears in the upﬁer left-hand corner. Next to this symbol,
is a Y indicating that FS-4 HD is following the state of the
camcorder’s tape controls, i.e. record when the camcorder
records and pause when it pauses.

Now the FS-4 HD will respond to the camcorder’s tape
controls. The recording signal goes both to the tape in the
camera and to the FS-4 HD.

Recording Timecode in the File

Select EXT TC in the Setup menu. This option records the video
camera timecode in the file. For other available timecode options
refer to TIME CODE EXT, REC RUN, FREE RUN, REGEN on page

67,.

@iote

Function buttons

The tasks discussed above are available for programming into the function
buttons. For information on setting up function buttons, refer to the section,
Functions Screen on page 72
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Playback on the FS-4 HD

Verify that both the video camera and the FS-4 HD are
powered on and that they are connected together with the
FireWire cable from the FS-4 HD DV/IO port to the
camcorder 1394 port.

@iote

Feature Availability on PAL Cameras
This feature is not available on some PAL cameras.

1.  Set the video camera to VCR or playback mode.

2. Navigate to the video clip to preview, using the FS-4 HD
Left and Right transport control buttons.

Play

|

Forward
Search

Transport Transport
(Back Index) (Forward Index)

3. Press the FS-4 HD Play button.

4.  Search through the clips using the FS-4 HD Forward Search,
Forward Index, Backward Index, or Backward Search
buttons. Refer to Navigation Buttons on page 9 for more
information on the function of these buttons.

@Note

Camcorder Compatibility with External Players
Some HD camcorders are not compatible with the external player
functions Forward/Reverse Search and Pause.
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Using the FS-4 HD with a Computer

Once video clips are recorded to the FS-4 HD it is possible to use
those clips in most computer based DV/HD NLE systems. This
section contains the following:

INItIAl SETUP e 34
Mounting the FS-4 HD in WindOWS .............ceiiiieainininiins 34
FS-4 HD and FAT 32 ... e e e e e 37
Using Avid OMF Clips FS-4Pro HD only..........c.ocooeiiiiinneee. 38
Dismounting the FS-4 HD (WINAOWS) ......cccooiiiieieeiiiiiiieeenns 41
Mounting the FS-4 HD (Macintosh) ........ccccccceciiiiiiiniiiiins 42
Dismounting the FS-4 HD (Macintosh) .........ccccccevviivieeenns 43

In the past, to get footage into an NLE system, it was necessary
to capture / digitize the footage using a video capture card.
The FS-4 HD'’s DTE functionality eliminates the capture stage.
All that is necessary is the moving of the video files from the
FS-4 HD to a computer. To do this:

* Connect the FS-4 HD directly to a computer with an

active OHCI compliant IEEE-1394 FireWire port and
the necessary FireWire disk drive drivers.

@iote

For More Information
Go to the Focus Enhancements' website (www.focusinfo.com) for
more compatibility information.

* Use the FS-4 HDD Bypass mode, refer to Initial Setup on
page 34 for more information.

The FS-4 HD is compatible with any computer system that can
read FAT 32 volumes, such as Windows 98SE/ME/2000/ XP
and Mac 0OS9/0S510.
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Initial Setup

1.

Connect the FS-4 HD through its COMPUTER I/0 1394 port to the
computer system using a standard 6-pin to 6-pin FireWire cable.

Enter HDD mode and enable DD Drive.
This step is required before mounting the FS-4 HD to a computer.

*  On the FS-4 HD go to the HDD screen.
¢ Select DD Drive and Right arrow to Connect screen.
* Press Enable function button.

Refer to the section, HDD Mode Screen on page 57

Connect power to the drive if necessary.

4. Consult the computer’s documentation for more information.

Mounting the FS-4 HD in Windows
Use this procedure for Windows XP, 2000, 98SE and ME.

1.

34

On a Windows-based computer system, double click the My
Computer icon on the top left hand corner of the desktop. A
directory window appears.

B My Computer =1o1x]
File Edt View Favorites Tools Help |
=Back - = - ‘ Qhsearch [Folders ¢4 ‘ g X w | E-

Address I@, My Computer j e
Mame + | Tvpe | Tokal Size I Free Space I

30 Flappy (A7) ] 2%-Inch Floppy Cisk

(=Local Disk. {C:) Local Disk. 5.85GE 1.56 GB

@Compact Disc (D:)  Compact Disc

(=ALocal Disk (E:) Local Disk. 13.2GB 10.4 GB

QCDmpact Disc (F:)  Compact Disc

S2public on Fsi' (G Metwaork Drive 548 GE 50,9 GE

E2Manuals on 'Fsi' (... Metwark Drive 543 GB 50.9 GB

PMpegs on Fs1' (M:)  Mebwork Drive S48 GEB S0.9 GE

[ Contral Panel System Folder

EIFSAPRO (1) Lacal Disk, erive ] 3T1GE

‘ID obiject(s) |@ My Computer 4

. Locate the FS-4 HD drive and open it.

Often, it appears as a standard FireWire disk drive and may be
labeled E:, F:, G:, and so on.

. Open the FS-4 HD disk icon.
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4. Open the folder with the most recent date code.

Be Et Vew Favortes Took Hep L]
Qs © B POsech e | [$ 00 X 9 |@Er
Address | e 1\ bl > 3
Mame ~ e Type Dute Modfied
Qo File Foder 7/14/2005 3:53 M
a1 Fie Folder 7/14/2005 3:53 PM
@z File Foider 7/14/2005 3:53 PM
a3 Fie Foider 7/14/2005 3:53 M
= Fie Folder 7/14/2005 3:53 P
Qs File Foider /1472005 3:53 M
@s Fle Foider FI14/2005 3:53 PM
a7 Fle Fokder FIIATIO05 3:53 PM
=t Fie Foider 7/14/2005 3:51 M
as Fle Folder /1472005 3:53 PM
B 20050803-164513-01 Fie Foider B92005 12:40 P
Qiog Fle Foider /372005 4:47 PM
Desiktop D8 4B0KE Fie 7/14/2005 3:53 PM
Desiktop DF G4KB Fie /1472005 3:53 PM

This folder may contain several different files. The video clips.
can appear as:

B E:\20050803-164513-01

Fle Edt Vew Favores Took Hep :
o © - F Pserch Brodes (&5 X 9 [~
Agdress | & E:\20050803-164513-01 ~ Bco
By 20050803-164654-01.dv 20050809-123952-01 o
DV Fie x| Mov Fe

24,141 KB 63,104 KB

20050809-124027-01
m MOV Fle
38,800 KB

* RawDV (.dv)
* AVITypel - (YYYYMMDDHHMMSSa01)

* AVIType2 or 24p AVI Type?2 -
(YYYYMMDDHHMMSSb01)

* Canopus AVI - (YYYYMMDD-HHMMSSb01)

* Matrox AVI - (YYYYMMDD-HHMMSSmO01
This file has a separate .wav audio file per track.

* QuickTime or 24p Quicktime (.mov)

FS-4Pro HD
* Pinnacle AVI - (YYYYMMDD-HHMMSSp01
There are two separate .wav audio files per track.

e Avid OMF (.omf)
OMF has two separate .aif audio files per track.
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* MXF OPAtom - (YYYYMMDD-HHMMSSp01.mxf)
(YYYYMMDD-HHMMSSLO1.mxf), -
(YYYYMMDDHHMMSSRO01.mxf) where:

p is video,
L is the left audio channel,
R is the right audio channel,

@note

FS-4Pro HD Video Clips in Reel Folder

FS-4Pro HD permits the storing of video clips in either the
standard file folder or a Reel folder. If video clips have been
assigned to a Reel folder, it is necessary to run Organize
Reels before attaching the FS-4Pro HD to a computer.

FS-4 HD Resolution and Frames

* M2T or QUICKTIME (MOV) filename format:
YYYYMMDD-HHMMSSX01.m2t or .mov where the X is a
letter indicating the resolution of the captured video file.
The table below lists letters and associated resolutions. Not
all HDV camcorders support these resolutions.

X Resolution X Resolution

d 720p, 23.976 fps D 1080i, 23.976 fps

b 720p, 24 fps B 1080i, 24 fps

c 720p, 25 fps C 1080i, 25 fps

a 720p, 29.97 fps A 1080i, 29.97 fps

e 720p, 30 fps E 1080i, 30 fps

f  720p, 50 fps F 1080i, 50 fps
720p, 59.94 fps G 1080i, 59.94 fps

H 1080i, 60 fps

756p, 50 fps *

g
h  720p, 60 fps
y
z 480p, 60 fps *

*The 576p, 50 fps and 480p, 60 fps resolutions are not
supported in the HD RECORDER QUICKTIME format. The unit
will not record these resolutions camera when in HD
RECORDER QUICKTIME format.
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FS-4 HD and FAT 32

The FAT32 file system limits file size to a maximum of 2GB or
approximately, 9 minutes of recording time.

@Niote

Recording Time Depends on Recorder Mode and Resolution
The number of minutes per 2G file depends upon the recorder mode and
resolution:

e DV -9 minutes,

e 720p (MOV) - 10 minutes,

e 720p (M2T) - 13 minutes,

* 1080i (M2T) - 9 minutes,

e 1080i (MOV) - 8 minutes (1080/60i) or 7.5 minutes (1080/50i),

When clips exceed 9 minutes in length, the FS-4 HD
automatically creates a new, file without dropping any frames.
The two files have the same root filename but have different
two digit suffixes that indicate the order of their creation, -01, -

02, and so on. This process can produce as many sequential
2GB files as the drive can hold.

With most NLE systems it is possible to use clips within the
timeline. Select the clips on the source volume, i.e. the
connected FS-4 HD, and import them directly into the NLE bin.

This makes clips immediately available in the NLE timeline.

The high transfer speed of the FS-4 HD drive permits direct
streaming of the clips to the NLE, thus eliminating the need to
copy or transfer the clips before their use.
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Using Avid OMF Clips FS-4Pro HD only

These steps are required when using Avid OMF formatted
clips.

The Avid OMF file format was developed for use with Avid
editing products on Windows 2000, Windows XP or Mac 0SX.
These products include Avid Xpress Pro, NewsCutter, and
Media Composer Adrenaline (with the DV option).

The Avid OMF file format creates three files simultaneously;
one OMF video file and two separate AIF audio files. On the
computer's desktop, the files appear similar to those shown
below.

G -5
Fi=  Edit Wew Fayores Tools Heip L
& -
() e - ewch Folders > i)
-]
= 200208 2%~
1314 3
L) 2083 25
I 300 200 24
HO 0
W 26-
e M0E %

B 200200 26-12 805001
Y 3000 2003 26 12 I ST
=l Deskiop DB
= Desiciop bF

On the FS-4 HD, the video file (OMF) and the audio files
(AIF) appear as one track.

When an Avid OMF file is deleted, the FS-4 HD deletes the
audio and video portions at the same time.

To use a FS-4 HD recorded Avid OMF file on an Avid NLE
system, use the following procedure.

@iote

ORGANIZE OMF Function

If using the ORGANIZE OMF function on the FS-4 HD before connecting it
to a computer, steps 2 and 3 are not necessary
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Locate and open the FS-4 HD drive folder.
Create a new folder and name it OMFI MediaFiles.
To do this in Windows, select File>New>Folder .

To do this with Macintosh, select File>New Folder. Next,
type OMFI MediaFiles.

Drag all the OMF and AIF files into the new folder:
Do Not Drag in the files titled Desktop DB or Desktop DF.

Launch Avid.
Open an existing project or create a new one.

Select Tools>MediaTool. A screen similar to the following
appears:

x
Medm Orivn(n Projects (s
[ +
TWEWRCIHD:)

Carmme! Frzmet
| =LA

0 @ v (s
o . Frecemens (ios
El _ vetaFies

[~

Locate and select the FS-4 HD under Media Drive(s).

@Note

If Drive Does Not Appear

If the drive does not appear, check to make sure that the OMFI
MediaFiles folder was created correctly with proper case and
spacing.In addition, verify that the drive is properly connected and
recognized by the computer. Under Project(s), select All
Projects (This highlights all items in the Project(s) window).

FS-4 HD and FS-4Pro HD Portable DTE Recorders 39



40

10. Verify that Master Clips is checked and press OK. The

11.

12.

13.

Media Tools Window, similar to the following, appears:
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Create a new bin (select File -> New Bin) or open an existing
bin in Avid.

Select all items in the Media Tools window (select Edit>
Select All).

Drag the contents of the Media Tools Window into the bin.
It is now possible to use these clips in the Avid timeline.
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Using the FS-4 HD with a Computer

Dismounting the FS-4 HD (Windows)
When finished working with the FS-4 HD and the computer, it
is necessary to dismount FS-4 HD from the system

Dismount FS-4 HD Before Powering Off
It is important to dismount the FS-4 HD from the Windows system
BEFORE powering down the unit.

To do dismount the FS-4 HD:

1. Click the Safely Remove Hardware icon at the bottom right side of
the Windows task bar as shown below.

& 4 (@S 12:13pM

Unplug or Eject Hardware Icon J

(Safely Remove Hardware)

2. Next, the computer system prompts to Remove the connected
FS-4 HD. This begins the dismount process.

3. Select the message and click on it.

The computer dismounts the FS-4 HD and then displays a
message that it is now safe to remove the unit.
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Mounting the FS-4 HD (Macintosh)

1. Start the Mac computer and connect the FS-4 HD’s COMPUTER I/
O port to the computer using a standard 6-pin to 6-pin FireWire
cable.

When mounted, the FS-4 HD should appear on the computer's
desktop as shown below:

M = 4)) Fri8:56AM |

E

Macintosh HD

F5083004

The FS-4 HD appears as a FAT32 volume with a PC label.
2. Locate the FS-4 HD on the desktop and open it up.

3. Open the folder with the most recent date code (for example,
20050127-110345-01). It should look similar to the following:

[~ 20030831-072915-01

J | 88 | Qr local disks
@Network - z —
@ 20030831-072917-01L.mov
g Macintosh HD [@ 20030831-073322-01.mov
Q FS083004 & [@ 20030831-073457-0L.mov
[@ 20030831-073505-01.mov
“Deskmp [@ 20030831-073508-01.mov

@ 20030831-073514-01.mov
& mattmcewen

A Applications
ﬁ Documents
ﬁ Movies
é Music

[ pictures

6 items, 35.75 CB available

@Note

Before Connecting FS-4Pro HD to a Computer
If clips have been assigned to a Reel folder: perform an Organize
Reels before connecting the unit to a computer.
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Using the FS-4 HD with a Computer

Dismounting the FS-4 HD (Macintosh)

When finished working with the FS-4 HD and the Macintosh it
is necessary to dismount the unit from the system.

{ |§ Dismount FS-4 HD Before Powering Off
It is important to dismount the FS-4 HD from the Mac system BEFORE
powering down the FS-4 HD.

To dismount the FS-4 HD from a Mac:

1. Select the FS-4 HD on the computer's desktop. It is marked with
a PC symbol.

2. Drag the drive into the trash or use the eject button. This
dismounts the particular disk drive.

3. Itis now safe to remove the FS-4 HD.

@Note

Eject Shortcut for Two-button Mouse
If the Macintosh is equipped with a two-button mouse, the following keyboard
shortcut is available:

* Right click the FS-100 icon on the desk top.
* Select the Eject function from the pop-up menu.
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Using the FS-4 HD with a Computer

Mounting Hardware

Mounting FS-4 HD to a Camcorder

Mount the FS-4 HD to your camcorder using the optional
Camcorder Mount Kit (P/N ASYF-0849-01). For more
information about this kit or to order it, contact Focus
Enhancements:

USA

Email: support@focusinfo.com
Telephone: +1 408 866 8300
Address: Focus Enhancements, Inc.

1370 Dell Avenue
Campbell, CA. 95008
www.focusinfo.com

EMEA (Europe, Middle East, Africa)

Email: techsupport@como.com
Telephone: +49 4307 - 83 58 58

Fax: +49 4307 - 83 58 99

Address: COMO Computer & Motion GmbHA

A Focus Enhancements Company
Lise-Meitner-Str. 15

24223 Raisdorf / Germany
www.focusinfo.com
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Using the FS-4 HD with a Computer

Clipping to a Belt

Belt Mount Clip
Front View  Side View

FS-4 HD
Belt Clip Post

A belt mount clip is included with the FS-4 HD. This mount is
similar to those used with cellular telephones. Attach the belt
mount to the belt clip post on the rear of the FS-4 HD and push
it down to lock it in position.
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FS Functions

This section contains information on the following LCD screens:

General Screen Information .........cccocceeeeiieiiiiii, 48
RECOI SCrEENS ..ottt e 52
HDD MOAE SCIrEEN ....ccoeiiiiiiiiieeeecre e 57
FOrmMat SCrEEN ...ccoeiie e 60
HD FOrmat SCreeN .......viiiiiiiiiiiieeeceeiie e 61
SEtUP SCIrEENS ...ciiiiiiieeeeeeetrr e e e e e e e e e e e e e e e eeeeaeennes 62
FUNCLIONS SCrEEN ..ot 72
ULIHtIES SCIEEN ooiee it 77
CONrOl SCIEEN ...ciiieeeeee et 94

FS-4 HD screens are organized in a flat hierarchy. Every screen
has a unique name, and it is possible to cycle continuously
through the screens using the Left and Right navigation buttons.

Use the Up and Down navigation buttons to cycle through
screen items (selections).

Use the Select navigation button to make a choice.

@Niote

Navigation Tip: Jump to Top of Display Using the Left Button

When navigating through the LCD displays and scrolling down into the
menu, press the Left navigation button on the front panel and immediately
return to the top of the display, which allows navigating to other displays.
Jump to Home display Using Select Button

To return immediately to the Home Screen, navigate to the menu title at the
top of the screen and press the Select button.
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General Screen Information

The FS-4 HD LCD screens are organized by function with each
screen displaying a list of items. An item can be:

¢ A value that can be set, such as the date.

¢ A switch similar to a check box, that can be enabled
along with other options in the display.

* A switch similar to a radio button, that belongs to a
family of options, in which only one can be active at
any time.

* Alink to another display, which is indicated by a p>.

SETUP Menu Title
Appears at the top of the
01/16/06 display and identifies its

topic or function.

09:30:19

V1.0.0
-LCDLIGHT ON

Navigation

Use the Left or Right Use the Up and Down
navigation buttons to move navigation buttons to move
to the previous or next between the items in the
display. display.

Welcome Screen

The Welcome screen appears briefly after boot-up, and
automatically switches to the Home screen when the FS-4 HD
is ready for operation.

FS-4 HD Varies
PORTABLE depending on

DTE RECORDER the model of
FS-4 HD
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Home Screen

The Home screen is read only and has no navigable items. To
leave the Home screen use either the Left or Right Navigation
button.

1 2

%L‘
W STOP1- =53
11 —k»COUNTER ' 47_ 4
12— 00:00:14:02 —
I DISK1 168 min <-— 6

10— REEL

FS-4Pr00r|‘]||3 ISYNC DISP LOCK
7 8 9

1. Current Function: Symbol and Description
Refer to LCD Display Symbols and Text on page 97.

2. Volume Disk Number
The volume number is always 1 unless multiple FS-4 HD’s
are connected.

3. Clip Number
Number of the current video clip, i.e. 001 for clip 1. The FS-4
HD supports a maximum of 999 clips.

4. Battery Life Gauge
This gauge is accurate only when the unit is powered
exclusively from the battery.

5. Timecode Value

Either Drop Frame - 00;00;00;00 or, Non Drop Frame -

00:00:00:00.

Time remaining on the disk.

7. FA Functions with SYNC as the default, refer to Functions
Screen on page 72 for more information.

8. FB Functions with DISP as the default, refer to Functions
Screen on page 72 for more information.

9. FC Functions with LOCK as the default, refer to Functions
Screen on page 72 for more information.

o
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10. Reel Display FS-4Pro HD only

In Record or Playback modes, this item displays the particular
REEL that a clip is located in or, has been marked to. If in
PLAY FROM > REEL LIST mode, the REEL appears in
brackets for example, <REEL>. This area is blank if NO
REEL has been selected.

11. DISP information field that displays data type.

12. DISP information field that displays current data.

DISP (display) Information Fields

Use the DISP function button to display current operation
information fields 11 and 12. The data shown depends on
the mode of operation, i.e. DV or HD Recorder.

Pressing the DISP button advances the display to the next
category of information. Below is a table of the data types
and data available with DISP.

Field Data Type /
Number Data Description
11 COUNTER
12 Shows frame count of current video clip during record or
playback.
11 REMAINING
12 Record: counts down number of available frames

remaining, as time, on a specific disk.
Playback: displays time remaining of the current clip.

11 DV (NTSC or PAL) or HD (see note following table)

12 Record: displays the external timecode value being
generated by a camcorder or other device during a
recording session. Timecode mode must be set to EXT
TC for this function to operate, refer to TIME CODE
EXT, REC RUN, FREE RUN, REGEN on page 67.
Playback: displays the embedded DV timecode value in
a particular track.

11 UB NTSC

12 Displays the set user bit value in a particular clip. A user
bit value must be added for this to display, refer to UB
SET (FS-4Pro HD only) on page 69.

11 ABSOLUTE

50 FS-4 HD and FS-4Pro HD Portable DTE Recorders



FS Functions

12 Displays an absolute timecode value for the particular
session: the sum of all COUNTER timecodes on
connected volumes.

Absolute is primarily used when setting the FS-4 HD to
AV/C mode and controlling it with an external FireWire
device, such as a computer.

@iote

DV (NTSC or PAL) and HD

The information displayed in fields 11 and 12 depends, in part, on which
Recorder Mode is set.

DV RECORDER

Line 11 displays the Standard Digital (SD) video format. It can not be
changed.

HD RECORDER

Line 11 displays the HD resolution of the current track which depends on
the camcorder in use with the FS-4 HD unit. Possible values are:

. 1080/50i TC
. 1080/60i TC
. 720/60 TC

. 720/50 TC

. 720/30p TC
.« 720/25p TC
.« 720/24p TC
. 576/50p TC

e 480/60p TC
Refer to the camcorder manual for supported resolutions.

FS-4 HD System Information Screens

The FS-4 HD automatically creates information screens to
indicate conditions such as high temperature, power
remaining, or drive capacity remaining.

WARNING

5%
POWER

REMAINING

Press OK to clear the screen and return to the last screen.
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Record Screens

NORMAL
-RETRO DISK

RETRO CACHE
LOOP RECORD

The Record screen permits setting the FS-4 HD to various
recording modes, depending on the model:

« NORMAL

e RETRO DISK FS-4Pro HD only

* RETRO CACHE

e LOOP RECORD FS-4Pro HD only

*  SNAP FS-4Pro HD DV modes only

e TIME LAPSE FS-4Pro HD DV modes only

Once a record mode is selected, the recorder remains in that
mode until a different mode is chosen. Exiting the Record
screen and returning to Home, enables the selected recording
mode.

To verify that the digital recorder is set to the correct recording
mode, refer to the upper left-hand of the Home screen where
the recorder mode is displayed.

Record Mode Indicator
(Retro Cache)

Symbol Indicates Notes
L Retro Disk FS-4Pro HD only
C Retro Cache
(0] Loop Record
SNAP Snap Record FS-4Pro HD only
T Time Lapse FS-4Pro HD only

52 FS-4 HD and FS-4Pro HD Portable DTE Recorders



FS Functions

For more about LCD display symbols and text, see LCD Display
Symbols and Text on page 97.

Normal Record

This is the standard recording mode.
e All control is from the FS-4 HD front panel.
Initially, the Home screen displays ®m STOP.

* Pressing Record e puts the FS-4 HD into I| REC PAUSE
mode.

* Pressing Record @ a second time puts the FS-4 HD into
REC mode.

Retro Cache Record Mode

:00
:SS <———This lineis not active:
reference only.

The Retro Cache mode insures that important material at the
very start of a recording session is captured. Retro Cache stores
in the on board memory a continuous loop of video captured
by video camera during pauses. Pressing Record @ begins
active recording at the last frame stored in the cache. The
resulting video clip has the cached video at the beginning.

Retro Cache is available in Local, Syncro Slave, and Tapeless
Trigger control modes.

FS-4 HD non-Pro

Settings enable or disable the Retro Cache. When enabled a
fixed 6 seconds of video is cached.

FS-4Pro HD

Set the length of video that the Retro Cache should store: 0 to
10 seconds.
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Retro Disk Record Mode Fs-4Pro HD only

HH:MM -&———F5— This lineis not active:
reference only.

The Retro Disk mode records video in a continuous loop to a
user-defined portion of disk space. Pressing Record e
seamlessly begins active recording. The Retro Disk session is
appended to the beginning of the new clip. The result is a set of
clips beginning with the cached video and continuing with the
newly recorded video.

*  When calculating the amount of hard disk space
needed for a Retro Disk record session, always include
additional space beyond the recording requirements.
The added space depends on the length of the loop.

* Loops less than 60 minutes, need an additional 1 minute
of unused disk space.

* Loops 60 minutes and greater, require an additional 2GB
of unused disk space.

*  When looping less than one hour, Retro Disk records
the loop in a series of 1 minute clips.

* Retro Disk is available in Normal, Syncro Slave and
Tapeless control modes.

*  When Retro Disk is set, the symbols eL (Record and L)
appear in the FS-4Pro HD display.
Loop Record Fs-4Pro HD only
Loop Record is similar to Retro Disk.

Loop Record continuously records a series of video clips to
available disk space. When all available disk space is used,
Loop Record begins sequentially replacing the earliest clip
with the most recent.
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* The size of the video clip depends on the length of the

loop.
*  Loops of 60 minutes or less are recorded in one-minute
clips.

* Loops greater than 60 minutes, are recorded in 2GB clips.

*  When the capacity of the disk is reached, one additional
clip is created. The size of the last clip depends on the
length of the loop i.e., one-minute or 2GB. The disk must
have at least 30 minutes of disk space available for this
functionality.

Saving Loop Record Clips
Press STOP during a record session.

The FS-4 HD stops recording and saves the current LOOP
RECORD session clips to a folder on the disk.

Snap Record Fs-4pPro HD, DV modes only

Use SNAP to record individual frames. In Snap mode, pressing
Record ® captures a single frame. Each record SNAP session
captures the individual frames into a single file. To start a new
SNAP record session place the unit in STOP between SNAP
records.

* SNAP Record is available only in DV modes of
operation.

e Use SNAP in Local, Syncro Slave, and Tapeless control
modes.

* Removing power from the FS-4Pro HD in the midst of a
Snap recording session causes the FS-4Pro HD to
return to Normal recording mode when it powers back

up.
@Note

Another Method to Capture Single Frames
An alternative to Snap is EXT CTL FRAME. For more information see
EXT CTL OFF, Pause, Frame, File on page 66.
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Time Lapse Record Fs-4pPro HD, DV modes only

00:00:00:00

HH:MM:SS:FF <&——3=—This line is not active:
for reference only.

Time Lapse provides the ability to record a single frame at
specific time intervals, for example one frame per minute,
00:01:00:00. Time Lapse applications can include capturing the
traffic on city streets, the growth of a plant from seed to
maturity, and construction projects.

Features of Time Lapse function include:
* All the captured frames are recorded in a single clip.

* The time between recording periods can be set in
frames, seconds, minutes, and hours.

¢ The maximum time between recorded frames is 24
hours.
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HDD Mode Screen

-DV RECORDER
HD RECORDER

DD DRIVE
USE EXT FS-4

Depending on the product, this screen displays the following
items:
* DV RECORDER
This sets the FS-4 HD as a DV recorder.
Connect the camera to the FS-4 HD DV 1/O port using a
FireWire cable.
* HD RECORDER
This sets the FS-4 HD as an HD recorder.
Connect the camera to the FS-4 HD DV 1/O port using a
FireWire cable.

Recording in this mode only works with HDV
camcorders that have a 1394 FireWire connector and
that support an HD resolution, such as 1080i or 720p.

@Niote

Switching Between Recorder Modes (DV and HD)
Switching between recorder modes resets the Record Mode to Normal, see
Normal Record on page 53.

« DDDRIVE >

Use this option when connecting the FS-4 HD to a
computer. The FS-4 HD functions as a volume visible to
the computer. In addition, this setting permits the
connecting of multiple FS-4 HD together to increase
recording space.
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» USE EXT FS-4

Use this option when longer recording times are
needed. USE EXT FS-4 permits the connecting of two
FS-4 HDs together to provide more disk storage for
longer recording. One unit acts as the master with the
other as a slave: the master records to itself until full
and then continues recording on the slave unit.

@Niote

Identifying Master/Slave Volumes During Record/Playback

When two FS-4 HDs are in combined via USE EXT FS-4 and in

either Record or Playback mode, the volume on the Home screen will
display 1-xxx when the master unit is recording or playing back and 2-
xx if it is the slave.
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Setting Up Master and Slave FS-4 HD

Slave FS-4 HD

DTE mcimouney
STOP 1 - 001
COUNTER COMPUTER THEN
00: 00: 00: 00 | ENABLE BYPASS
DISK 1 000min | SUCCESS
SYNC DISP LOCK EXIT

1. Connect the camcorder to the master FS-4 HD, DV I/0 connector
using the supplied FireWire cable.

2. Master
Power on unit.
Go to the HDD Mode menu screen and enable USE EXT FS-4.

3. Connect the FS-4 HDs through their Computer I/O connectors
using a 6-pin to 6-pin FireWire cable.

4. Slave
Power on the unit
Go to the HDD Mode screen and enable DD DRIVE.

5. Master
Begin recording or playback using the master FS-4 HD.

& Use DD Drive Mode when Connecting to a PC
It is important to take the master FS-4 HD out of USE EXT FS-4
mode before attempting to connect to a computer.
To do this, select DD DRIVE from the HDD Mode screen.
This returns the unit to hard disk mode.
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Format Screen

DV Formats

AVI TYPE1

AVI TYPE2
CANOPUS AVI

DV formats include:

¢« RAW DV

AVI TYPE1

e AVITYPE2

¢ CANOPUS AVI

¢ MATROX AVI

e QUICKTIME

¢ AVID OMF FS-4Pro HD only
*  QUICKTIME 24P NTSC only
e AVITYPE2 24P NTSC only
e PINNACLE FS-4Pro HD only
¢ MXF OPAtom FS-4Pro HD only

@Niote

Using Organize

AVID OMF, MXF OPAtom and PINNACLE formats require using the Utilities
functions, Organize OMF, Organize MXF, or Organize PINN respectively.
Refer to the section, Utilities Screen on page 77.

Formats for 25P Applications
Use standard file formats for all 25P applications except AVID OMF. OMF is
not compatible with 25P DV streams.

The latest DTE supported applications and file formats are
listed on the Focus Enhancements website:
www.focusinfo.com.
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HD Format Screen

The FS-4Pro HD provides the additional HD DTE format
QUICKTIME.

The latest DTE supported applications and file formats are
listed on the Focus Enhancements website:
www.focusinfo.com.

Check regularly for updates.
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Setup Screens

10/10/05
21:10: 50

vV 2.0.0
-LCDLIGHT ON

The items on the Setup Screen are grouped by function. Within
the function the items act like radio buttons, i.e. when one is
active the others are not.

In some cases, such as the Date, a settings screen appears. To
return from a settings screen, use the BACK function button.

The items displayed on the Setup screen include:
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DATE Displayed P
TIME Displayed p»
VERSION Displayed P>

LCDLIGHT ON Group Default
LCDLIGHT OFF
LCDLIGHT AUTO

ALARM ON Group Default
ALARM OFF

STOP FRAME; (1st frame of current clip)
STOP GRAY
STOP NO VIDEO Group Default

EXT CTL OFF Group Default
EXT CTL PAUSE
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EXT CTL FRAME
EXT CTL FILE

TC EXT Group Default

TC REC RUN DV mode or FS-4Pro HD only
TC FREE RUN Fs-4Pro HD only

TC REGEN FSs-4Pro HD only

TC SET P FS-4Pro HD only

UB SET p FS-4Pro HD only

TC DROP NTSC only
TC NON-DROP Default, NTSC only

HDV TC TYPE HD mode (FS-4Pro HD only)

LCD CONTRAST

Date and Time Must Be Set

The date and time must be set. They are used in the FS-4 HD file naming
function.

Refer to Set Time and Date on page 26.

Date

SET DATE

09 /18 /05

MM/DD/YY

BACK
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Time
SET TIME
10 : 50 : 40

Version

2.0.0.04070406

NTSC

FS-4Pro HD

This screen displays:

e FS-4 HD Firmware version
* SDvideo of the unit.
e FS-4 HD model
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LCD Light ON, OFF, AUTO
These items enable or disable the FS-4 HD's LCD backlight.

LCDLIGHT ON Group Default

Keeps the backlight on permanently.
LCDLIGHT OFF

Keeps the backlight off permanently.
LCDLIGHT AUTO

Turns off the backlight after one minute.

On the FS-4 HD, pressing any button pad button turns
the backlight back on. Any information screen turns the
backlight on.

Alarm ON, OFF

Default is On.

When the alarm is enabled, pressing any button on the
FS-4 HD produces audio feedback.

The FS-4 HD alarm triggers when conditions such as
low battery charge, low disk space, or over heating
occur.

When Alarm is set to Off, the audio feedback for the

buttons is disabled, however the alarm will still sound
for low power, high heat, or low disk space conditions.

Stop Frame, Gray, No Video

These settings determine which video is output from the FS-4
HD when using the Search Index keys to view recorded clips.

STOP FRAME DV only

Displays the first frame of the clip.
STOP GRAY DV only

Displays a black frame.

STOP NO VIDEO Group Default

Video output is Off.
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EXT CTL OFF, Pause, Frame, File

These options permit the use of an external device to control
the FS-4 HD through the optional RS-232 cable.

@Note

RS-232 Cable Available from Focus Online Store

The RS-232 cable required to connect the FS-4 HD to an external control
device is Focus part number CBLA-0113-01. It and other accessories
mentioned in this manual are available at https://www.focusinfo.com/sales/
store.

EXT CTL OFF

Use this option when connecting an external device

with an RS232C cable.

* This requires the use of a a 3.5mm-to-DB9 adapter cable,
plugged into FS-4 HD Control port.

In Local mode, select this item to control the FS-4 HD

with the optional wired remote control unit, refer to

page 94.

The following options permit control functions to occur from a
simple contact closure.
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EXT CTL PAUSE
Controls Pause and Resume during a record or playback
session.

EXT CTL FRAME DV Mode Only

Captures a single frame of video and records it to a file.
Each time this function is triggered, it sequentially adds
another frame to the same file until stopped.

EXT CTL FILE
Creates a new file during a record session without
losing any frames.
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TIME CODE EXT, REC RUN, FREE RUN, REGEN

The FS-4Pro HD provides additional TC REC RUN, TC FREE RUN,
and TC REGEN functionality in HD RECORDER mode. This
functionality is only active when HD FORMAT is set to
QUICKTIME. In M2T mode, all TC modes act as TC EXT.

The following are timecode (TC) functions.

e TC EXT Group Default

Records the incoming source timecode. If the timecode
is not running, and the FS-4 HD records the same
timecode number in each recorded frame. Choose TC
EXT mode to clear any stored number.

e TC REC RUN DV mode or FS-4Pro HD only

This function creates a time code number for the first
frame of the next recording. To do this it can either:
* FS-4HD
Take the last timecode recorded and add 1,
*  FS-4Pro HD
Use the value stored in TC SET.

The FS-4 HD stores the last recorded timecode in its non-
volatile memory, so it can persist across recording sessions.

e TC FREE RUN Fs-4Pro HD only
This function causes the FS-4Pro HD to begin counting

from the value stored by TC SET.

* A number entered through TC SET is not stored and
available to the FS-4Pro HD until exiting TC SET. Only
then does the FS-4Pro HD begin counting using that
number.
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e TC REGEN Fs-4Pro HD only

When the FS-4Pro HD powers up in TC REGEN mode, it:

e Reads the timecode of the last track recorded.

e Adds1 to the number.

* Stores the new timecode as the number that will be
assigned to the first frame of the next recording session.

If the drive is empty, i.e. no existing recordings, the

FS-4Pro HD uses the TC SET value.

@iote

TC SET and UB SET Can Be Set at the Same Time
Both parameters, TC SET and UB SET, may be set and are not mutually
exclusive as in some groups, i.e. LCDLIGHT.

TC SET Fs-4Pro HD only

TC SET

00: 00:00:00
HH: MM : SS: FF

The Timecode Set parameter stores a user defined timecode in
the FS-4Pro HD’s non-volatile memory. This value is available
for use by the FS-4Pro HD immediately after exiting TC SET.

e TC FREE RUN Fs-4Pro HD only

The FS-4Pro HD uses this value on the next recording
after it is set in TC SET.

e TC REGEN FS-4Pro HD only

This is the starting value when using an empty hard
disk drive for recording.

« TCRECRUN

This is the value used to begin every recording session
after a power cycle.
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UB SET Fs-4Pro HD only

UB SET
FF:FF:FF:FF

The User Bit Set function provides the ability to change the
user bits in the timecode recorded in the video files.

¢ Timecode values are not set when in TC EXT mode.

Professional applications employ user bits to add metadata to
recordings to assist in post production. For example, multiple
cameras are used during a shoot. Each FS-4Pro HD has a
unique UB setting that identifies it and the camera it serves.
Later, the user bits are used to determine from which camera
station the footage was recorded.
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TC DROP, NON-DROP NTSsC only

These parameters are only available for NTSC and only one
may be enabled at a time. Drop and non-drop enable and
disable the drop-frame function that modifies how the
timecode is calculated during recording.

e TC DROP Group Default

Enables the drop-frame function and frames 00 and 01
are dropped from each minute of video recorded, with
the exception of the first minute of the hour.

» TC NON-DROP

Disables drop-frame.

No frames are dropped during recording and the
timecode reflects the actual time during recording.

HDV TC TYPE Fs-4Pro HD only

HDV TC TYPE

-TTC
GOP TC

REC TC
PTS

This menu sets the source of the timecode displayed in the TC
DISP mode, while in HD RECORDER mode. This is also the
timecode reported in AV/C control mode.

* TTC (Title Timecode)
* GOP TC (Group of Pictures Timecode)
* RECTC (Recorded Timecode)

* PTS (Presentation Timestamp)
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Each NLE utilizes a different HDV TC TYPE for its workflow.
Use the following table to determine which HDV TC TYPE is
utilized by a particular NLE:

720p 1080i
Avid GOPTC TTC
FCP TTC TTC
Edius TTC TTC

See your NLE users guide for more information.

LCD CONTRAST

SET CONTRAST
VALUE: 00

Use this function to adjust the contrast of the LCD display for
easier viewing.

1. Use the Right navigation button to go to the SET CONTRAST
submenu.

2. Use the Up and Down navigation buttons to increase and decrease
the contrast number.

3. Press BACK when done.
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Functions Screen

The Functions buttons FA, FB, and FC provide convenient
Home screen shortcuts by acting as toggle switches for specific
system settings. The Home screen below is an example of the
information displayed.

N STOP 1-

COUNTER |
00:00:20:15
DISK 1 168 min

Reel receiving —— = R1
clips.

Function Keys

FA FB FC
Function Groups

Function settings are user-assignable and available in the
Functions screen. Changing a setting with a Function button
has the same effect as manually changing the setting.

FUNCTIONS

-FA SYNC
FAAV/C

FA TAPELESS
FA REELS

* There are three groups of functions FA, FB, and FC
displayed via the Functions screen.

* The function groups are independent of each other.

* Ineach group only one selection is active at a time.
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FS Functions

A list of the Function button menu is below. In each group, the
default selection is listed first.

MENU Appears on LCD as...

FA SYNC SYNC Toggles between SYNCRO and LOCAL record control.

FA AV/IC AV/C (Toggles between AV/C and LOCAL control)

FA Tapeless TAPE (Toggles between Tapeless TRIGGER and LOCAL control)
Default

FA REELS REEL Increments current reel number, FS-4Pro HD only

FA R0O-0 RO Marks Current Clip to Reel 0, FS-4Pro HD only

FA R1-1 R1 Marks Current Clip to Reel 1, FS-4Pro HD only

FA R2-2 R2 Marks Current Clip to Reel 2, FS-4Pro HD only

FA R3-3 R3 Marks Current Clip to Reel 3, FS-4Pro HD only

FA R4-4 R4 Marks Current Clip to Reel 4, FS-4Pro HD only

FA R5-5 R5 Marks Current Clip to Reel 5, FS-4Pro HD only

FA R6-6 R6 Marks Current Clip to Reel 6, FS-4Pro HD only

FA R7-7 R7 Marks Current Clip to Reel 7, FS-4Pro HD only

FA R8-8 R8 Marks Current Clip to Reel 8, FS-4Pro HD only

FA R9-9 R9 Marks Current Clip to Reel 9, FS-4Pro HD only

FA LCD ON/OFF

LCD1/LCDO0 LCD On/Off Toggle

FA LCD AUTO LCDA/LCDO LCD Auto On/Off Toggle

FA BLANK No Function.

FB DISP DISP (Toggles the different TC display modes) (Default)

FB ALARM ALRM/MUTE Turns the FS-C alarm on or off.

FB FILE FILE (Toggles between normal and display of the file name)
FB REELS REEL Increments current reel number, FS-4Pro HD only
FB RO-0 RO Marks Current Clip to Reel 0, FS-4Pro HD only

FB R1-1 R1 Marks Current Clip to Reel 1, FS-4Pro HD only

FB R2-2 R2 Marks Current Clip to Reel 2, FS-4Pro HD only
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MENU Appears on LCD as...
FB R3-3 R3 Marks Current Clip to Reel 3, FS-4Pro HD only
FB R4-4 R4 Marks Current Clip to Reel 4, FS-4Pro HD only
FB R5-5 R5 Marks Current Clip to Reel 5, FS-4Pro HD only
FB R6-6 R6 Marks Current Clip to Reel 6, FS-4Pro HD only
FB R7-7 R7 Marks Current Clip to Reel 7, FS-4Pro HD only
FB R8-8 R8 Marks Current Clip to Reel 8, FS-4Pro HD only
FB R9-9 R9 Marks Current Clip to Reel 9, FS-4Pro HD only
FB BLANK No Function.
FC LOCK LOCK/UNLK Locks the buttonpad (Default) - toggles between
LOCK and UNLK <Unlock>
FC DV/DD DD Toggles FS-C between DV/HD and HDD Modes
FC REELS REEL Increments current reel number, FS-4Pro HD only
FC R0O-0 RO Marks Current Clip to Reel 0, FS-4Pro HD only
FC R1-1 R1 Marks Current Clip to Reel 1, FS-4Pro HD only
FC R2-2 R2 Marks Current Clip to Reel 2, FS-4Pro HD only
FCR3-3 R3 Marks Current Clip to Reel 3, FS-4Pro HD only
FC R4-4 R4 Marks Current Clip to Reel 4, FS-4Pro HD only
FC R5-5 R5 Marks Current Clip to Reel 5, FS-4Pro HD only
FC R6-6 R6 Marks Current Clip to Reel 6, FS-4Pro HD only
FC R7-7 R7 Marks Current Clip to Reel 7, FS-4Pro HD only
FC R8-8 R8 Marks Current Clip to Reel 8, FS-4Pro HD only
FC R9-9 R9 Marks Current Clip to Reel 9, FS-4Pro HD only
FC BLANK No Function.
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LOCK/UNLK:

UNLOCK KEYS

PRESS SELECT
TO CONFIRM

This function is a toggle switch that locks and unlocks the keys on
the FS-4 HD's front panel.

The prevent accidental unlocking of the front panel, there is an
unlock confirmation screen:

1. Press the UNLK key.
2. Press SELECT to unlock the front panel keys.
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Assigning Clips to Reels

COUNTER
00:00:20:15
DISK 1 168 min

Currently —»> R1
Selected Reel E REEL R2 R3
Function FA
set to FA REELS
Function FB Function FC

set to FB R2-2 setto FC R1-1

The function buttons are a quick way to mark video clips
during recording. The Functions menu offers two types of
markers to use, as an example FA REELS and FB R2-2.

* FAREELS

Selecting the FA REELs programs the FS-4Pro HD to
mark the clips to the currently selected reel. The current
reel is indicated in the line above the FA function reel
selection.

* FBR2-2

Setting a function button to this type of marker,
instructs the FS-4Pro HD to mark the current clip as
belonging to the REEL R2.

Blank

Functions identified as Blank are inactive.
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UTILITIES

ORGANIZE REEL
ORGANIZE OMF

ORGANIZE MXF
ORGANIZE PINN

The Utilities available are:

ORGANIZE REEL FS-4Pro HD only
ORGANIZE OMF Fs-4Pro HD only
ORGANIZE MXF FS-4Pro HD only
ORGANIZE PINN FS-4Pro HD only

DELETE CLIP p

FORMAT p

REPAIR DISK p

REPAIR CLIP p DV mode only
FILE NAME p

UPGRADE p

SYSTEM RESET p
DIAGNOSTIC p

STATUS p
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@Niote

Organize Functions are Mutually Exclusive

Once one organize utility is performed on a set of files, another organize
function can not be applied. For example, if the Organize OMF is used on a
set of files, then Organize Reel can not be applied to them.

Organize Reel Fs-4Pro HD only

This selection places all files identified as a REEL clip during
recording or playback into the appropriate reel folder. You can
import this folder directly into most DV NLE bins.

Organize OMF Fs-4Pro HD only

When files are recorded in the AVID OMF file format, this
selection allows you to take all the OMF and AIF audio files at
the end of a recording session and place them into a folder on
the disk drive named OMFI MediaFiles. When the disk is
connected to a computer, this folder is recognized by Avid
Xpress DV's Media Tool enabling direct import of files into the
Avid timeline. Refer to the section, Using Avid OMF Clips FS-4Pro
HD only on page 38 for more information.

Organize MXF Fs-4Pro HD only

When using MXF OPAtom with some NLEs, such as AVID
Xpress Pro, it is necessary to do an Organize MXF. This is
available in the Utilities menu.

The Organize MXF:

¢  Moves all MXF video files into the
/contents /video directory.

e  Moves all MXF audio files into the
/contents /audio directory.

* Updates and moves the xml files from the log directory
into the /contents/clip directory.

* Generates thumbnails of the clips in the
/contents /icon directory.
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Organize Pinn Fs-4Pro HD only

This selection organizes clips for use with Pinnacle Liquid
series NLE systems. Products such as the Pinnacle AVI file
format were created for use with products such as Pinnacle
Liquid Edition. The Pinnacle AVI file format creates three files
simultaneously during a recording; an AVI video file and two
separate WAV audio files labeled as left and right. An
additional ALE file for each recording session is also created
which contains timecode data. This file must be kept with the
media.

Once clips have been imported into Liquid Edition, an Index
file is created on the disk drive for each clip. Do not delete this
file since it is required to continue work in the particular
project.
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Delete Clip

DELETE CLIP
CLIP 001

YES BACK

Use this item to delete a selected clip.

1. From the Utilities screen, go to the DELETE CLIP screen.

2. Enter the number of the clip to be deleted using the Up and Down
navigation buttons.

3. Press the YES function key.
The selected clip is deleted.
4. Press BACK to return to the Utilities screen.

When a Chp is deleted, the FS-4 HD re-organizes and displays

the remaining clips in sequence. For instance, if there are three
clips on the disk: 1-001, 1-002, 1-003. If clip 1-002 is deleted, the
remaining clips are reorganized and clip 1-003 becomes clip 1-
002. However the base file names are not affected.

@iote

Use Delete Function Sparingly

The delete function should be used sparingly. It is suggested that the
DELETE CLIP utility be used only when absolutely necessary. It can cause
disk fragmentation that can lead to file playback and record issues. If more
space is required you must transfer your content from the FS-4 HD and
perform the FORMAT utility. Refer to Format Disk on page 81.
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Format Disk

FORMAT DISK

PRESS YES TO
ERASE ALL DATA

YES BACK

Prevent lost frames due to file fragmentation by formatting the
FS-4 HD before each recording session.

A Save Files Before Formatting
The formatting process erases all data on the disk and is not reversible.
Backup all files and clips on the FS-4 HD before formatting.

This selection formats the disk as follows:

1. From the Utilities screen, go to Format Disk.

2. Select YES to begin formatting.
A status screen displaﬁ/s progress of the formatting and at
completion displays the message:

* Complete indicating Repair Disk was successful.

* Aborted indicating that there were errors and the repair
did not complete.

3. Press BACK to return to the Utilities screen.
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Repair Disk

REPAIR DISK

PRESS YES TO
REPAIR DISK

YES BACK

Use this function if a recording session does not complete
properly and there is a question that the file may be damaged.
For example, recording terminates due to a loss of power to the
FS-4 HD. Repair Disk scans the entire disk drive checking for
and repairing file errors and incomplete files. When the file is
repaired it is can be used in the NLE system.

@iote

Corrupted Files May Need More Repairs
After running Repair Disk some files may still need further work to restore
them. In such a case, run the utility Repair Clip, refer to the following page.

To repair a disk:

1. From the Utilities screen, go to Repair Disk.

2. Select YES and the FS-4 HD begins repairing the disk.
A status screen displays the progress of disk repair and at
completion displays the message:
* Complete indicating Repair Disk was successful.

* Aborted indicating that there were errors and the repair
did not complete.

3. Press BACK to return to the Utilities screen.

@iote

After Using REPAIR DISK Move Content and Re-Format

After using the REPAIR DISK utility, the content must be moved from the
FS-4 HD's drive and the FS utility FORMAT run before resuming recording.
Refer to Format Disk on page 81.
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Repair Clip bv mode only

REPAIR CLIP

CLIP 001

YES BACK

Use this function to repair a specific file that may be damaged
or incomplete. For example, recording terminates due to a loss
of power to the FS-4 HD and a specific file may be damaged.
Repair Clip scans the specified file checking for and repairing
file errors and incomplete files. When the file is repaired it is
can be used in the NLE system.

1. From the Utilities screen, go to Repair Clip.

2. Enter the number of the clip to be repaired, using the Up and
Down navigation buttons.

3. Press YES and the FS-4 HD begins repairing the file.
A status screen displays the progress of disk repair and at
completion displays the message:

» Complete indicating Repair Disk was successful.

* Aborted indicating that there were errors and the repair did
not complete.

4, Press BACK to return to the Utilities screen.

@Note

After Using REPAIR CLIP Move Content and Re-Format

After using the REPARI CLIP utility, the content must be moved from the FS-
4 HD's drive and the FS utility FORMAT run before resuming recording.
Refer to Format Disk on page 81.
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File Name

FILE NAME
CLIP 001

20041101 -
165423

This function Displays a file name but does not permit changing
it.
1. From the Utilities screen, go to FILE NAME.

2. Enter the file’s clip number using the Up and Down navigation
buttons.

The base file name is dynamically displayed as a function of the
clip number.

When a clip has multiple files, the first Base file name is displayed

3. Press BACK to return to the Utilities screen.
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Upgrade

Check Focus Enhancements website for upgrades and latest
software updates, go to www.focusinfo.com.

To upgrade system software:

1. Set the FS-4 HD to DD DRIVE from the HDD MODE screen and
connect it to a computer.

2. On your computer, rename the XXX.bin file as FS4.bin.

3. Copy or drag the FS4.bin file to the FS-4 HD while it is in DD
DRIVE mode.

4. Exit the FS-4 HD from DD DRIVE mode and navigate to the
Utilities screen.

5. From the Utilities screen, go to Upgrade.

6. Press Right. The following screen appears.

UPGRADE

PRESS SELECT
TO UPGRADE

SOFTWARE

BACK

7. Press Select.

8. A confirmation screen appears: press YES to continue.
A status screen displays the progress of the upgrade.

UPGRADE
UPGRADING ...
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9. Up on successful completion of the upgrade, the FS-4 HD
displays the message:

UPGRADE
COMPLETE

PLEASE RESTART

10.Hold down the STOP / POWER OFF button until the FS-4 HD
shuts down.

11. Power up the FS-4 HD.
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Upgrade Error

If the upgrade fails, the FS-4 HD displays one of the following
messages:

UPGRADE ERROR

WRONG PRODUCT
ID

* Wrong Product ID

Verify that the upgrade is for the model of FS-4 HD
it is being installed on. An upgrade is not cross-
platform and must be installed on the model for
which it is intended.

To find the specific model of a FS-4 HD go to the
SETUP screen and then version (2.0.0), refer to Setup
Screens on page 62.

UPGRADE ERROR

FILE
NOT FOUND

* File Not Found

Verify that the upgrade file name is fs4.bin and that
it is in the FS-4 HD hard drive’s root directory.
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System Reset

SYSTEM RESET

CONTINUE TO
RESET

SYSTEM?
YES BACK

The System Reset feature restores the factory default settings
for the FS-4 HD unit. This feature is useful for diagnosing
problems with the unit.

System Reset
A System Reset can not be reversed.

Diagnostic

A DO NOT CHANGE THE SETTINGS OF THIS FUNCTION

This function is included to assist Focus Enhancement
Technical Support diagnose problems that may occur with the
FS-4 HD.
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Status

The FS-4 HD Status screen provides details of the systems
power state as well as internal temperature. This screen may
assist Focus Enhancements Technical Support in determining
power and thermal problems with your unit.
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Reels Screen rs-4pro HD only

When a disk is formatted, the FS-4Pro HD creates 10 folders,
numbered 0-9, on the disk. During recording or playback of a
clip, it is possible to place it into folders or play it from up to 10
different reels.

These folders can have any name up to 10 characters in length.
To name the folders it is first necessary to enter DD DRIVE mode
and mount the FS-4Pro HD to a computer.

Placing a Clip in a Reel

From the Reels screen, choose the Reels as follows:

1. From the Utilities screen, go to Reels screen.
Values include:
¢ FA RO-0 Default Value

* FA R0-0 through R9-9 “Reel Name”

2. Select a reel from the list.

When selecting a REEL from this screen, the current track is
marked with that REEL number. This can be done in any mode:
record, stop, or playback.
Each of the function keys can be set to specific reel, making it
possible to quickly switch between multiple reels: a total of
three reels being the maximum. Refer to Functions Screen on
page 72 for more information.
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Using a Wired Remote Control

When using the optional wired remote control, use the button
pad numbered 0-9 to mark the clips. Any additional button
presses during a recording or playback, changes the selected
REEL. Once a session is finished, select Organize REEL in Utilities
screen. The marked clips are placed in the REEL folders in
sequential order.

When a REEL is selected, the Home screen menu displays the
REEL’s name on the left side of the second to the last line of the
screen, refer to LOCAL on page 94.

@iote

Optional Wired Remote Control (p/n ACSS-0019-01)

To order the Wired Remote Control, go to Focus Enhancements website,
www.focusinfo.com/sales/store/.
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Play Screen

PLAY

PLAY CLIP
LOOP CLIP

LOOP ALL
PLAY ALL

e Play Clip
In this mode, the FS-4 HD plays the selected clip from

start to finish when you press the PLAY button. At the
end of the particular clip, the FS-4 HD pauses.

 Loop Clip
In this mode, the FS-4 HD plays the selected clip from
start to finish. Immediately after completing the clip,
the FS-4 HD begins playing the clip again without a
pause. It stays in this state until stopped.

e Loop All

In this mode, the FS-4 HD plays the entire contents of
the disk (all clips), in order, from start to finish. At the
end of the last clip, the FS-4 HD begins to play from the
beginning of the first clip again without a pause. It stays
in this state until stopped.

* Play All

In this mode, the FS-4 HD plays the entire contents of
the disk (all clips) in order, from start to finish. At the
end of the last clip, the FS-4 HD pauses.
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Play From Screen rs-4 Hp only

PLAY FROM

TRACK LIST
REEL LIST

This screen permits the selection of from where clips playback.
There are two choices:

e Track List

Clips playback in the order in which they were
recorded. Playback order is based on the order of the
file names.

* Reel List

Clips in a selected folder are played back. This function
provides the ability to choose between any folders on
the disk. Folders can appear with their user assigned
folder name (if used).
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Control Screen

AV/C

-SYNCRO SLAVE
TAPELESS

The Control screen provides the capability of enabling the FS-4
HD to operate in four different control modes during record
and playback.

« LOCAL

Local control mode ignores record triggers from the
camcorder and is controlled exclusively from the FS-4
HD front panel or the optional wired remote control
unit.

Transport
Keys

Keeper
(cycles through
Reels)

0-9 REEL |
numbers

* Transport keys have the same functions as on the FS-4
HD.

94 FS-4 HD and FS-4Pro HD Portable DTE Recorders



FS Functions

* Usethe Keeper ¢ key to cycle through the available
Reels. For example, if the current Reel selection is 3.
pressing Keeper changes the selection to Reel 4.

To purchase the wired remote control, p/n ACSS-0019-
01, for the FS-4 HD, visit Focus Enhancements web site
at www.focusinfo.com/sales/store/.

« AVIC
@iote

Do Not Use AV/C control in Record Mode

Use AV/C in playback mode and other situations
where the FS-4 HD is controlled by an external FireWire
device such as a NLE system that is not supported by
Direct To Edit Technology. In these cases, the FS-4 HD
can be used in a manner similar to a camcorder to
capture footage to the NLE.

In AV/C control mode the TC value reported to the controller
or NLE is the value displayed on the Main menu. Pressing
the DISP changes the source of the TC. The DISP TC mode
selects the TC embedded in the DV/MPEG-2 stream. When
in HD RECORDER mode, and the QUICKTIME HD
FORMAT is selected, the type of timecode reported is
defined by the HDV TC TYPE setting, refer to HDV TC TYPE
on page 70.

@iote

Using Absolute (ABS) Display Mode

It is recommended that when operating in AV/C mode, the reported
timecode source be changed to Absolute (ABS). This is done through
the LCD DISP mode information fields, see DISP (display)
Information Fields on page 50.

* Syncro Slave

In Syncro Slave mode, a camcorder and the FS-4 HD
follows the camcorder’s record state. It requires a tape
to be in the camcorder. To use this mode, refer to the
section, Syncro Slave Recording on page 30.
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» Tapeless Trigger

The Tapeless Trigger mode allows the FS-4 HD to be
controlled from a camcorder if it features an external
control setting separate from the tape transport. Typical
camcorders like this include the Sony DSR 370, DSR-
390, DSR-400, DSR-450, DSR-570, Canon XL1s and XL2
and the Panasonic DVX-100/-100A.

In addition, the FS-4 HD also supports HDV camcorders
with external control.

@iote

Camcorder Requirements for Tapeless Trigger

Tapeless Trigger will not work unless it is supported by the camcorder
and the camcorder is placed in this external control mode. Please
check your camcorder manual for more details.
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The table below shows the different symbols and states
displayed on the top line of the LCD when used with different
FS-4 HD control, record, play and stop modes:

PLAY/REC MODE
Stop

Pause

Play

Rec (Pause)

Normal Rec (Rec)
Retro Disk (Stop)
Retro Disk (Standby)
Retro Cache (Stop)
Retro Cache (Standby)
Loop Record (Stop)
Loop Record (Standby)
Loop Record (Rec)
Snap (Stop)

Snap (Standby)

Snap (Rec)

Time Lapse (Stop)
Time Lapse (Pause)
Time Lapse (Rec) T

FS-4 HD LCD

STOP
I PLAY
» PLAY
I REC
REC
STOP
REC
STOP
REC
STOP
REC
I OREC

STOP

|| SNAP

|| SNAP

STOP

| TREC
REC

oo nan -
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CONTROLTYPE FS-4 HD LCD

AV /C* (Stop) A STOP

AV /C* (Rec Pause) || A <REC TYPE> REC
AV /C* (Rec) A <REC TYPE> REC
AV/C* (Play Pause) || APLAY

AV/C* (Play) A ALL

Syncro Slave (Pause) || 'Y <REC TYPE>REC
Syncro Slave (Rec) Y <REC TYPE>REC
Tapeless (Pause) || E<REC TYPE>REC
Tapeless (Rec) E <REC TYPE>REC

* AV/C is only for use when the FS-4 HD is connected to a
computer system.
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Technical Specifications

Specifications are subject to change.

Physical Description

* Dimensions: 1.59" x 5.6" x 3.74" (40mm x 142mm x
95mm) (with normal 90 minute Battery)

*  Weight: 11b. (45 kg)

Input/Outputs

* DV Video I/O -25Mb/s (1x 6-pin IEEE-1394)
On HD units this port can accept 720P and 1080i MPEG
video from specially equipped camcorders.

* FireWire Computer I/F - up to 400Mb/s (1 x 6-pin
IEEE-1394)

*  GPI & RS-232C Control (1 x 3.5mm mini jack)

Power
* 15V DC,75W
* Mini-jack power connector

* Custom Removable Li-ion Rechargeable Battery Pack
(90 minutes estimated run-time)

FS-4 HD and FS-4Pro HD Portable DTE Recorders 99



Technical Specifications

Audio/Video/Timecode Specification

* 25Mb/s, 8-bit 4:1:1 (NTSC-DV) or 4:2:0 (PAL-DV) video
(model dependent). The HD models support 720p 24/
25/30 and 1080i 50/ 60 from HDV camcorders with a
1394 interface.

* DV Embedded Timecode (Drop or Non-Drop)

*  Embedded 2-ch (16-bit, 48kHz) or 4-ch (12-bit, 32kHz)
Audio

DTE File Formats

* RawDV, AVITypel, AVI Type2, Matrox AVI, Canopus
AVI, QuickTime, AVI Type2 24p NTsC only, QuickTime
24p NTSC only

e M2THD

® FS-4Pro HD only
Pinnacle (DV)
AVID OMF (DV)
MXF OPAtom (DV)
QUICKTIME (HD)

Disk Information

* Internal Disk Type: 5400RPM, 8 MB cache
FS-4 HD: 40GB
FS-4Pro HD: 60GB, 80GB or 100GB

¢ Disk Format: FAT32

* FS-4 HD compatible with Windows 98SE, ME, 2000, XP
and Mac 0OS9/10.
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Technical Specifications

Log Files

With each recording of a particular clip on a disk, the FS-4 HD
creates a text log file to identify information about the recorded
clip and the recording session. Information includes:

* Clip name

* Clip in/out source TC values
* Clip duration

* Clip type (record file type).

The log file also identifies when the shock cache becomes low
and when disk or other errors occur during a recording.

Error Messages

Error messages may appear on the FS-4 HD LCD display from
time to time. The purpose of these messages is to alert you to
action that may effect your FS-4 HD operation. Below is a list of
error messages and actions you can take:

Error Message Description Action

LOW BATTERY! Battery power is low. Connect AC Power or replace the
battery pack. When the unit is run
without the battery installed, this

warning can be displayed, that is

normal.

HIGH The unit is getting too hot Make sure the vent and fan intake

TEMPERATURE! for normal operation. holes are clear.

NO SPACE LEFT! The Disk Drive is Full. Transfer files off the drive and format it
before attempting to do more
recording.

DISK ERROR Lost Disk Communication. Contact Focus Enhancements

XXX Technical Support.

NO DISK Lost Disk Communication. Contact Focus Enhancements

DETECTED Technical Support.

WRONG Incorrect Software Loaded. Download correct software and

PRODUCT ID perform upgrade again.

FILE NOT FOUND Wrong filename or missing Check filename or that upgrade file

file. exists.

TRK LIMIT MAX! 999 clips exist on system. Copy content from FS-4 HD hard drive

and re-format.
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Technical Specifications

Warranty
* 1year, FS-4 HD
* 2years, FS-4Pro HD
* 90 Days Accessories including the battery.

Temperature
* Operating: 0-40° C (32 - 104° F)
* Operating humidity: 30% to 90% RH
* Storage temperatures: -20 to 60° C (-4° to 140°F)
* Storage humidity: 85% RH or less

Compatible Camcorders and Accessories

For a list of tested camcorders, refer to www.focusinfo.com.
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